# CONNECTED 8.2
## Release Notes

**Introduction** ........................................................................................................ 3
**Minimum System Requirements for Connected 8.2** ........................................... 3
**Connected 8.2 Installation** .................................................................................... 3
**Enhancements** .................................................................................................... 4
  **General Enhancements** .................................................................................... 4
    **Advanced Email Templates** ............................................................................ 4
      Adding/Editing Email Templates ..................................................................... 5
    **Sample Invoice Email Template – Plain Text (PC)** ...................................... 5
    **Sample Invoice Email Template – HTML (Mac OS)** .................................... 6
  **Cross Platform Access to Note File Attachments** ............................................. 6
  **Helper Windows Added to Ledgers** .................................................................. 6
  **File Backup** ..................................................................................................... 7
    **Using the Backup Data Utility** ..................................................................... 8
    **Warning on Time Machine in Mac OS** ......................................................... 9
  **Connected ODB Server Data Manager – PC Servers** ..................................... 9
  **Data Exchange** .............................................................................................. 10
  **PCI Compliance for Card Processing** ............................................................. 10
  **General Ledger** ............................................................................................. 10
    **Accounts Window** ..................................................................................... 10
      **Expanded Record Info** ............................................................................. 10
      **New Previous Totals Tab** ......................................................................... 11
    **Financial History Report** .......................................................................... 11
    **Bank Reconciliation – Group EFT Payments** ............................................ 11
    **General Journal Delete Date** ..................................................................... 12
  **Accounts Receivable** .................................................................................... 12
    **Location Name and Pop-up List** ................................................................ 12
    **Field Level Security for Customers Applied in all A/R Windows** ................. 12
    **Customer Activity Ledger Enhancements** ............................................... 13
    **Sales Ledger – “Pay Type” Column** ......................................................... 13
  **Accounts Payable** ....................................................................................... 13
    **Custom Purchase Fields** ........................................................................... 13
    **Payments Window** ................................................................................... 15
    **Vendors Activity Ledger Enhancements** ................................................... 15
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Orders</td>
<td>16</td>
</tr>
<tr>
<td>Shipments Tab Layout and Totals</td>
<td>16</td>
</tr>
<tr>
<td>Order Confirmation Password Protection and Record Info</td>
<td>17</td>
</tr>
<tr>
<td>Order Required Date Transferred to New Est Delivery Date</td>
<td>17</td>
</tr>
<tr>
<td>Purchase Orders</td>
<td>18</td>
</tr>
<tr>
<td>Custom Purchase Fields</td>
<td>18</td>
</tr>
<tr>
<td>Inventory Control</td>
<td>18</td>
</tr>
<tr>
<td>Inventory Query Window</td>
<td>18</td>
</tr>
<tr>
<td>Inventory Item Query Quick Lookups</td>
<td>19</td>
</tr>
<tr>
<td>Customizing the Item Query Display Columns and Resetting the View</td>
<td>21</td>
</tr>
<tr>
<td>Using the Inventory Advanced Find in the Item Query Window</td>
<td>22</td>
</tr>
<tr>
<td>Exporting Query Results</td>
<td>23</td>
</tr>
<tr>
<td>Option to Make Lot Expiry Mandatory</td>
<td>23</td>
</tr>
<tr>
<td>Job Costing</td>
<td>24</td>
</tr>
<tr>
<td>Job Profitability – Summary Export</td>
<td>24</td>
</tr>
<tr>
<td>Job Name Search</td>
<td>24</td>
</tr>
<tr>
<td>Multiple Currency</td>
<td>24</td>
</tr>
<tr>
<td>Report Layouts with Multiple Currencies – PC Version</td>
<td>24</td>
</tr>
<tr>
<td>Importing</td>
<td>25</td>
</tr>
<tr>
<td>Purchases Detailed Import – New Fields</td>
<td>25</td>
</tr>
<tr>
<td>Purchase Order Import – New Fields</td>
<td>25</td>
</tr>
<tr>
<td>Purchase Order Receiving Import</td>
<td>25</td>
</tr>
<tr>
<td>Import Notes:</td>
<td>26</td>
</tr>
<tr>
<td>Special Character Handling:</td>
<td>27</td>
</tr>
<tr>
<td>Maintenance and Fixes</td>
<td>28</td>
</tr>
</tbody>
</table>
Introduction

Thank you for choosing CONNECTED for all your accounting and business needs. The following instructions will assist with installing and using the latest version 8.x program software.

If you have questions or need further assistance please do not hesitate to contact the Connected Support team:

Email: support1@accountek.com
Phone: 888-414-2196
Web: https://support.accountek.com

Minimum System Requirements for Connected 8.2

Visit https://www.accountek.com/system-requirements/ for the most current CONNECTED system requirements. It is important that the system requirements be reviewed prior to installation.

Connected 8.2 Installation

Please refer to the installation instructions that were received with your update download. If you are unable to locate these instructions, please email support1@accountek.com. Do not attempt to install the 8.2 update without first reviewing these instructions.
Enhancements

General Enhancements

Advanced Email Templates
Emailing invoices, sales orders, sales quotes, statements, purchase orders, and payment advices is now much easier with the following changes:

- Create email templates with field tags such as invoice number, amount, date, customer name, and many more
- Multiple email templates can be added/modified/stored in virtually every screen in Connected. For example, when sending an invoice chose from a standard template or a “past due” template that have been created for each instance.
- Email templates support plain and html format. NOTE: We have found that HTML works best on Mac OS version of Outlook
- Open and view the email before sending, allowing additional files to be attached, or send directly to your Outbox

The following is a sample of how the email templates work for customer invoices.

To open the “Address Email” window, select Address Email Message from the Contacts menu as shown in the following screen.

Make the email selections of the recipients, attach file, template (optional), and send options. The following screen shows an email addressed to a single recipient, using a template, and with “Compose” selected to open the email before sending.
Adding/Editing Email Templates

Templates can be added, edited, or deleted in the Address email window by using the controls to the right of the Template label. Templates are stored for each area, and sometimes window, in Connected. For example, the “Invoice” email templates are available from the Account Invoice, Credit Memo, Debit Memo, and Invoices Report that is used for batch sending.

Sample Invoice Email Template – Plain Text (PC)

Subject:
Acme Inc Invoice #[ARIN_INVNUM]

Message Body:
Please find the attached invoice for your goods and services.

Invoice Details:

Date: [ARIN_INVDATE]
Inv No: [ARIN_INVNUM]
Amount: [ARIN_AMOUNT]

Please contact us with any questions.

Sincerely,
Acme Inc Customer Service
888-678-5856
connected@accountek.com
Sample Invoice Email Template – HTML (Mac OS)

**Subject:**
Acme Inc Invoice #[ARIN_INVNUM]

**Message Body:**
Please find the attached invoice for your goods and services.<br>
Invoice Details:<br>
Date: [ARIN_INVDATE] <br>
Inv No: [ARIN_INVNUM] <br>
Amount: <b>[ARIN_AMOUNT]</b> <br>
Please contact us with any questions.<br>

Sincerely, <br>
Acme Inc Customer Service<br>888-678-5856<br>connected@accountek.com

**Cross Platform Access to Note File Attachments**
The Note Attachments feature has been enhanced so that users in mixed PC and Mac networks can read the notes folder, no matter which platform is being used to serve the data. Since the network path may differ in syntax between PC and Mac, the path can now be plotted from each platform separately so all users can easily access the same files.

**Helper Windows Added to Ledgers**
Helper windows have been added to the Sales Order, Sales Quote, Purchase Order, and Work Order ledger windows. Helper windows show Contacts, Notes, Record Info, and Pins.
The following shows a sample of the helper window location in the Sales Order ledger:

- **Contact**: Click Contact, when the line is highlighted to email the specific line item or view the Contacts window for the Customer or Vendor assigned to the entry.

- **Notes**: With the a line selected, click the Notes icon to view, add, or edit notes for the specific entry.

- **Record Info**: With a line selected, click the Record info to view the specific record information for the selected line.

- **Pin**: With a line highlighted, click the Pin icon to pin or unpin an entry.

**File Backup**

A new “Backup Data” option has been added under Utilities menu to create zip files archives of the current Connected data file - the data file that you are logged into. This can be helpful to quickly archive data files in a compressed format.

**WARNING**: These instructions are for backing up data through the Connected Accounting and ERP software. It is not recommend to use this as your company’s sole backup method but rather to be one of multiple different methods to create multiple copies of your accounting data in different locations.

Important notes about how the this new feature works and backups in general:

- The backup utility is password protected. Any user, except the designated Administrator of a Connected data file must be granted password access to access the utility.

- Backups cannot be performed with users logged into the data file. Connected must be able to confirm it is in single user mode before a backup can start.

- Managing user access to the Connected data when a backup is being performed is important. No user should attempt to login to the Connected data file while a backup is being performed as to insure that the backup is not interrupted and/or corrupted.

- When using the ODB Server software on a Mac or PC server, there is no direct file path to the data as it should be stored in a unshared folder on the server. In this case, backups should be done from a local copy of Connected on your server when the ODB
server is shutdown, ensuring no user access. The ODB Admin utility, built into the Connected application for PC servers only, has a built-in backup function for server-side backups.

**Using the Backup Data Utility**

To use the Backup Data Utility:

1. **Select Utilities from the File menu and choose Backup Data File.**
   
   **NOTE:** If you are not a System Administrator, the “Backup Data” user privilege must be granted for it to be visible.

2. The following **Back Up Data File** window will appear. The file name, current file path, and data file size will all be listed.

   ![Backup Data File Window]

   If your data file is set to use “Note Attachments” a checkbox will be automatically added to “Include note attachments” when the backup is made.

   **NOTE:** For best performance, especially with large data files and attachments folders, the backup process should be performed on the same machine on which the file is located. Including attachments will increase the backup time and file size.

3. **Click Proceed** to continue. If your data file is still being accessed by other users, the following message will appear and the backup will be blocked.

   ![Backup Failed]

4. If the data file can be set to single user mode, you will be prompted with a window to name and save the file backup. The default file name for the backup is “Backup_MMDDYYYYHHMMSS.zip”. The following file name is an example of a file backed up on 10/31/2017 at 3:22:26pm: Backup_10312017152226.zip

5. When the back up is completed, the following message will appear:
Warning on Time Machine in Mac OS

Time Machine is an automatic backup that's built into Mac OS. If Time Machine has been set to backup your Connected data file, then please note that Time Machine does not backup open files. If your company relies on Time Machine for backing up your accounting information, make sure you close Connected on all work stations before a scheduled backup.

Additionally, Time Machine will likely cause performance degradation, sometimes very severe, on both the work station and server that it is running on.

**WARNING:** If you have a multi-segment Connected data file, **Time Machine will make incorrect backups in many cases.** It should not be relied on in any instance that a company data file has more than a single segment.

Connected ODB Server Data Manager – PC Servers

Connected 8.2 includes a new server manager for PC based servers. The manager is built into the Connected application and manages data files in an optimal way. To review/install the server software, please email support1@accountek.com, which will start a ticket, requesting the documentation and necessary download files.
Data Exchange

The following changes have been made to the Data Exchange:

— Increased the text box size from 128 characters to 256 so that longer text string formulas can be entered.
— When selecting the export files, the fields are now numbered making it easier to insert fields in a specific location for large export formats.

PCI Compliance for Card Processing

For users that are starting to process credit cards with Blue Pay and have used the credit card fields in past versions, the following is important:

— Activating the credit card processing within Connected will hide the old credit card fields but will not purge the data
— To permanently purge the data from these fields, before or after activation, contact our Support Department for instructions.

PLEASE NOTE: To be PCI Compliant, customer Credit card information never be stored.

General Ledger

Accounts Window

Expanded Record Info
The Accounts window now supports expanded record info to help track when accounts were added and/or modified. The date, time, and user name will be tracked for each time an account is added (after Connected 8.2 is installed), and each time the account is modified.
New Previous Totals Tab

A new tab called Previous Totals has been added to the Accounts window. This tab allows the history fields, used in the Financial History Report to be viewed and/or edited.

![Accounts window showing Previous Totals tab](image)

Financial History Report

The “Financial History” report has been enhanced to support five years of Balance Sheet reports. Each year is shown side by side and the entire report will fit onto a single Portrait page (left to right).

![Financial History Report](image)

Bank Reconciliation – Group EFT Payments

A chance has been made to the Bank Reconciliation that will help display entries, as shown on a bank statement, when electronic or ACH payments are being used. This can be helpful when a single amount withdrawn is shown on the bank statement for a group of vendor payments.

To enable this feature, select Company Setup from the File menu and choose G/L Defaults. Select the “Group EFT Payments on Bank Reconciliation” as shown in the following screen.

![Bank Reconciliation settings](image)
General Journal Delete Date

If a general journal entry is added and deleted before it is posted, the Record Info on the entry will now track the date, time, and user of when the entry was deleted.

Accounts Receivable

Location Name and Pop-up List

If the Multiple Locations setting is enabled, the following screens have been modified to show the location Name and have the Location pop-up list available during data entry.

Sales Orders
Account Invoices
Add from Quote (Sales Orders)
Cash Invoices
Customers (default location selection)

In previous versions, only the location number was displayed and a pop-up list was not available.

Field Level Security for Customers Applied in all A/R Windows

The field level security that was introduced into the Customers window in Connected 7.3 has been expanded to all windows in the Accounts Receivable module. If a user has been blocked from editing the Sales Rep, Tax Code, and/or Terms Code in the Customers window, they will also be blocked from the following screens:

- Account Invoices
- Cash Invoices (all fields always available for one-time invoices)
- Debit Memos
- Credit Memos
- Sales Orders
- Sales Quotes

In all cases the value can be viewed but not edited.

This can have several benefits:

- Blocking ability to change terms which can affect how a customer’s credit is handled
- Blocking the ability to change the rep code can help enforce sales rep and/or commission rules
- By not being able to edit these fields, it saves two TAB stops in the footer of these screens. Combine this with the blocking of line item Price and Discount, specific staff can have data entry expedited and less prone to errors

Customer Activity Ledger Enhancements
The Activity ledger in the Customers window has been modified to help isolate entries by type and to more easily identify payments.

The following screen shows the location of the new “Type” column, which shows the transaction source, and the “Receipt No” column. The Receipt No column will only have data for Receipt (Customer Payment) entries. Both of the new columns are included in the Print window report and spreadsheet export.

Sales Ledger – “Pay Type” Column
A new column for “Pay Type” has been added to the Sales Ledger window. This column will only show values for Cash Invoices from the “Pay Type” field.

Accounts Payable

Custom Purchase Fields
The A/P Purchases window has been modified with a new tab for “Custom Purchase” fields. This fields had previously been available in the Purchase Order window only, with the label of “Custom PO Fields”.

To enable the Custom Purchase fields, if they were not previously enabled, select Company Setup from the File menu and choose A/P Defaults. Click the Custom Purchase Fields tab, as shown in the following screen.
To make a field active, simply add a label. Only fields with labels will be active. Add default entries if specific data should be included by default when a PO or a Purchase is added.

🌟 TIP: The first two fields are searchable and add new options in the Purchases or Purchase Order window Find, as shown in the following screen.

If Custom Purchase fields are used to track information on a Purchase Order, when the Vendor Invoice is created from the PO, all data will be transferred to the corresponding Purchase from the Custom fields.

Like the Custom Sales fields in the A/R, Custom Purchase fields can be edited after a Purchase is posted, which is shown in the following screen.
Payments Window

Payments window (aka Checks) now shows a date in the details section of a Normal Payment for Pre-Payments. In past versions, this field was blank making it difficult to identify which prepayment was to be matched against specific invoices, when multiple prepayments were issued for a single vendor.

Vendors Activity Ledger Enhancements

The Activity ledger in the Vendors window has been modified to help isolate entries by type and to more easily identify vendor payments.

The following screen shows the location of the new “Type” column, which shows the transaction source, and the “Payment No” column. The Payment No column will only have data for vendor payments. Both of the new columns are included in the Print window report and spreadsheet export.
Sales Orders

Shipments Tab Layout and Totals

The shipments tab has been modified to display a new layout with new fields for order metrics. The new order metrics are displayed in sections for Order Total, Unshipped, Ship Now, Shipped to Date, and Back Ordered. Each section includes a total and percentage for Quantity, Amount, and Weight.

The new layout can be seen in the following screen.

*TIP:* To select the color of the fields, right click and choose from the color menu. This setting will be remembered by user so that each can have their own color selection.
**TIP:** The "Ship Now $" and "Ship Now %" fields are available as columns in the Sales Order ledger and can be selected as required.

**Order Confirmation Password Protection and Record Info**

Sales Order "Confirmed" checkbox is now password protected so that users can be blocked from confirming a sales order. In addition, each time an order is marked as confirmed/unconfirmed a record info entry is added to show the user/date/time of the action.

See the *Configuring User Accounts and Password Access* of the Getting Started section of this User Guide under the Help menu for more information.

**Order Required Date Transferred to New Est Delivery Date**

Sales Order required date (Order Required Date) is now passed to the new "Est Delivery Date" field in the Account Invoice, when an order is shipped. The new field is available in the Sales Ledger so that the Order Required Date and Est Delivery Date can be compared, typically for an efficiency analysis.
Purchase Orders

Custom Purchase Fields

The Custom PO fields have now been relabeled “Custom Purchase Fields”. All fields with values will now transfer to the corresponding purchase(s) (vendor invoices) created from a Purchase Order.

Inventory Control

Inventory Query Window

The Inventory Item Query window is a powerful search window that combines aspects of multiple inventory reports, ledger screens, and a search window into a single screen.

NOTE: If the Inventory Item Query window is not visible, it may need to be enabled in the User Privileges window.

To open the Inventory Item Query window, select Inventory Item Query from the I/C menu, as shown in the following screen. The window can also be opened from the Connected Navigator.
**TIP:** When the Inventory Item Query window is first opened, it will show a list of all items that have been added within the last 30 days, which avoids unexpected load times for large item lists on the default load. To see a list of all items, select the “Any Date” filter from the **Date Added:** selection and reload the list. This filter location is shown in the following screen.

![Inventory Item Query](image)

**TIP:** All inventory items listed in can be double clicked to drill into the corresponding Inventory Item window.

### Inventory Item Query Quick Lookups

The Inventory Item Query window has a series of quick lookup options that are as follows:

- **Item Range:** Select from All Items, Range of Items, Items with Analysis Code, or Items with a specific Vendor Code (primary vendor)
- **Type:** Select from **Inventory**, **Service**, and/or **Master** type items. This setting can be used with all other quick lookups.
- **Status:** Select from **Active** and/or **Inactive** items. This setting can be used in conjunction with all other quick lookups.
- **Last sales order date:** The sales order can be set can be set to: Any Date (default), Today, Yesterday, Tomorrow, This Week, Last Week, This Month, Last Month, This Year, Last Year, Within Last 30 Days, Within Last 60 Days, Within Last 90 Days, Within Last 180 Days, or a Date Range can be specified. **NOTE:** The last sales order date field is updated only when an order is shipped or partially shipped. When the shipment is created, the Sales Order date is updated.
- **Last purchase order date:** The last purchase order date can be set can be set to: Any Date (default), Today, Yesterday, Tomorrow, This Week, Last Week, This Month, Last Month, This Year, Last Year, Within Last 30 Days, Within Last 60 Days, Within Last 90 Days, Within Last 180 Days, or a Date Range can be specified. **NOTE:** The last purchase order date is updated when a PO is posted.
— **Date Added**: The date added for an item can be set can be set to: Any Date, Today, Yesterday, Tomorrow, This Week, Last Week, This Month (default), Last Month, This Year, Last Year, Within Last 30 Days, Within Last 60 Days, Within Last 90 Days, Within Last 180 Days, or a Date Range can be specified. **NOTE**: The date added field is a new field added in Connected 8.2. Only items added after that time will have a value in this field.

**Location Quantity Quick Filters**

To display and filter using location item quantity metrics, the **Search Locations** checkbox must be selected. Quantity metrics like “Available Qty” or “SO Qty” are only available when “Search locations” is selected. A sample of how this filter works is shown in the following screen:

![Inventory Item Query](image)

**Search Locations quick filters**

— **Location Range**: Select from All Locations or specify a Range
— **On hand qty**: Select from any combination of the following filters for on hand quantity:
  - Plus due qty from purchase orders
  - Less back ordered qty from sales orders
  - Less committee qty
  - Specify a quantity filter based on the following choices:
Customizing the Item Query Display Columns and Resetting the View

To customize the columns displayed in the Item Query window, select **Change Columns** from the **Actions** menu as shown in the following screen.

The following change columns window will appear. Simply check the columns you wish to appear.

🌟 **TIP:** The order of the columns can be changed by clicking on the option in the list, holding your mouse button, and dragging it to the desired location.
Using the Inventory Advanced Find in the Item Query Window

The Item Query window is equipped with the powerful inventory item Advanced Find option allowing multi-tiered queries to help filter large item lists for very specific results.

To use this feature, select the **Use Advanced Find** checkbox as shown in the following screen.

To define a query:

— Choose a field to query on. In the following screen, three fields have been selected, "Item No", "Available Qty", and "Type". More fields can be added by selecting the + sign to the right of the query entry.
In this example, the Item No can be queried by selecting “Begins with”, “Equals to”, or “Contains”. For example if you query the Item No for any code that contains “E”, all items that have codes that contain with E in the Item No field will appear in the results window.

To drill in to an item, double click on it to open the Inventory Items window.

Exporting Query Results

To export the results of the Item Query window, select **Text File** or **Spreadsheet** from the **Print** menu as shown in the following screen.

Option to Make Lot Expiry Mandatory

A new “Expiry Date Required” option has been added to items that are controlled by either Lot or Serial number. If an item has “Expiry Date Required” selected, an expiry date will be mandatory for all incoming inventory movement (PO Receivings, IC Receivings, Credit Memo, and Manufacture).

The location of the new checkbox is shown in the following screen.
Job Costing

Job Profitability – Summary Export

A new “Summary Export” option has been added to the Job Profitability report. The new option creates a flattened export of the “Summary” version of the report so that it can easily be sorted and manipulated in a spreadsheet.

The location of the new report option and a sample of the report output are shown in the following screens.

Job Name Search

Job Name Search in jobs window is no longer case sensitive. Previously an exact case match was required to find a job by its name.

Multiple Currency

Report Layouts with Multiple Currencies – PC Version

Report layouts, when multiple currencies are enabled, have been altered and scaled to fit on either a single Portrait or Landscape page. The layout changes affect PC users only.
Importing

Purchases Detailed Import – New Fields
Added support for new Custom Purchase fields. The Purchase Detailed import supports the modern import framework so fields can be mapped, however, the default location of the new fields are in position 16-26.

Purchase Order Import – New Fields
The Purchase Order import has been enhanced to support the following new fields:

Order No (17) – Customer Order Number
Expected Date (18) – Expected date, by line item
Est Arrival (19) – Purchase Order Estimated Arrival

Purchase Order Receiving Import
The new Purchase Order Receiving import supports CONNECTED’s modern import framework and allows custom field mapping and import preview.

To access the Purchase Order Receiving Import, select Import from the File menu and choose Purchases Order Receivings. The following screen will appear.
NOTE: Import files must be tab-delimited text files.

Importable fields include (in default field mapping order):

1. Purchase Order No - required; must be a valid purchase order number
2. Receiving Date - required; must be a date within the current accounting periods
3. Packing Slip No - required; 10 characters max; must be a unique value for vendor
4. Inventory Item No - required; must be a valid inventory item number
5. Quantity Received - required; must be a positive number with a maximum of two decimal places
6. Exchange Rate - required; must be a positive number with a maximum of four decimal places
7. Duty Rate - must be a positive number with a maximum of four decimal places
8. Freight Rate - must be a positive number with a maximum of four decimal places

Import Notes:
- Receivings cannot be imported if there are already unposted receivings for the purchase order.
- Receivings cannot be imported for unposted, closed or cancelled purchase orders.
- Receivings cannot be imported for controlled items or for cancelled lines.
- Receivings cannot be imported for more than one packing slip per purchase order.
- Receivings belonging to the same packing slip should be contiguous rows in the import file.
- When there are duplicate item numbers on the same purchase order, imported quantities are received against them in line number order.
- All imported quantities are received even if they exceed the receivable quantity on the purchase order.
- If non-zero amounts are not imported for exchange, duty and freight rates, default values will be used.
- Auto-confirmation of receivings will be utilized if it is enabled in the A/P Defaults window.
Special Character Handling:
Import values containing single and double quote characters and carriage returns cannot be directly imported. Using a text editor application, these characters must be removed and substituted with the following strings prior to importing. During the import process, the substitute strings will then be replaced with the original characters. Substitute /dqt/ for double quotes, /sqt/ for single quotes and /rtn/ for carriage returns. The forward slashes must be included.
# Maintenance and Fixes

#0003113: [A/R] Resolved issue for Recurring Invoices in non HOME currency that used the incorrect A/R Account

#0002521: [G/L] Income Statement Report issue resolved on Gross Profit Calculation. Issue only occurred when the report was run with a Department Range, Separate Statements, and % of total revenue selected.

#0002513: [G/L] Fixed issue with Trial Balance report that showed, in some instances, zero activity accounts when "Suppress Zero Activity" was selected.

#0002868: [A/R] Problem resolved with Sales Order that caused a loop when the "Item Info" tab was selected after a quantity available warning.

#0003051: [G/L] Resolved issue with Income Statement that caused zero activity accounts, in some instances, to be shown when "Suppress Zero Line" was selected.

#0003035: [G/L] Resolved issue with Balance Sheet report that showed zero activity accounts, in some instances, when "Suppress Zero Line" is selected.

#0003164: [A/R] Resolved issue with Incomplete Orders report that caused overlap on long item codes.

#0003137: [G/L] Resolved issue with Financial History report that allowed periods past period 12 to be entered. Report now only accepts periods 1 - 12.

#0003092: [A/P] Fixed issue on Quick Pay Payment that cased cursor to stick in PO number field.

#0003150: [A/P] Resolved issue that blocked a PO from being edited when outside the current 18 open periods when the "Modify PO in Closed Periods" user privilege was enabled.

#0003148: [Year End] Resolved issue that caused a customer balance to change when there was unposted Miscellaneous Receipts during a year end processing.

#0003061: [I/C] Added time stamps that were missing from the following inventory reports: Master Item list Detail / Summary, Price List Summary / Detail, Sales Analysis, Manufacture, Production, Consumption, MRP, Inventory Valuation, Inventory Movement, IC Transactions, Restocking

#0003073: [A/R] Resolved issue that caused incorrect customer margin calculation on Customer Sales History report for customers in different currencies only.

#0003075: [A/R] Issue resolved that caused the balance not to be cleared when a payment was received with a discount

0003234: [PO] Receivings Report (Export Version Only) Issue resolved that caused only the first 20 characters of item description to show.
0003074: [SO] Resolved issue in Picking list report that caused item list not to sort correctly in some instances

0003273: [Import] Import Inventory count issue resolved that caused an error message after import for the Withdrawal entry when a specific account was assigned for withdrawal entries

0003238: [A/P] Issue resolved in PO Receivings window that caused the date field to not be highlighted on Modify.

0003277: [Import Purchase Orders] Resolved issue with the PO Import that allowed Negative PO Number and/or Non Numeric value based on incorrect data provided in import file.

0003272: [A/R, SO] Incomplete Orders Report changed to show line items net of discount, if applicable.

0003292: [Forms/Forms Editor] Issue resolved that caused setting to be ignored when selecting show commas and Negatives in brackets on form fields.

0003287: [A/R] Sale Margin button issue resolved that caused inconsistencies in certain scenarios.

0003305: [A/P] Post Payments Pre posting report now shows long vendor names without overlap of other columns.